
Avid® Editing Application 
ReadMe for Media Composer® v8.4.2

IMPORTANT: Avid periodically makes software updates available for download on 
Avid.com at the following location:www.avid.com/us/support/downloads. Please 
check the above site regularly for information on available downloads for your 
product.

Important Information

Avid® recommends that you read all the information in this ReadMe file thoroughly before 
installing or using any new software release.

Important: Search the Avid Knowledge Base for the most up-to-date ReadMe file, which 
contains the latest information that might have become available after the documentation was 
published.

This document describes compatibility issues with previous releases, software installation 
instructions, hardware and software requirements, and summary information on system and 
memory requirements. This document also lists hardware and software limitations.

http://www.avid.com/support/downloads
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.
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If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after the 
documentation was published. Also check online for the most up-to-date ReadMe because 
the online version is updated whenever new information becomes available. To view the 
online ReadMe, select ReadMe from the Help menu, or visit the Knowledge Base at 
http://www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues. In addition to the printed documentation supplied 
with your editing application, the documentation is supplied in PDF format when you install 
the application. Topics that you print from the Help have limited page layout and formatting 
features. If you want to print a higher quality version of Help information, Avid recommends 

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

(Windows), (Windows 
only), (Macintosh), or 
(Macintosh only)

This text indicates that the information applies only to the specified 
operating system, either Windows or Macintosh OS X.

Bold font Bold font is primarily used in task instructions to identify user interface 
items and keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Command+Option+C or Ctrl+drag.

Symbol or Convention Meaning or Action

http://avid.force.com/pkb/articles/en_US/readme/Media-Composer-Software-8-0-Documentation
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that you print all or part of the PDF version of the appropriate Avid manual included in the 
Online Library for your editing application. To access the Online Library, select Help > 
Online Library from within your Avid editing application. 

4. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 24 
hours per day, 7 days per week. Search the Knowledge Base to find answers, to view error 
messages, to access troubleshooting tips, to download updates, and to read or join online 
message-board discussions.

Fixed in v8.4.2

The following have been fixed in Media Composer v8.4.2:

➤ Bug Number: MCCET-832. The aspect ratio did not appear correctly for edit while capture 
clips. In some instances a 16:9 clip would appear as 4:3 in Media Composer.

➤ Bug Number: MCCET-744. In some instances, Media Composer would freeze when exporting 
XDCAM 50 media to ISIS storage.

➤ Bug Number: MCDEV-3944. If you were in RGB 709 color space with bit depth set to 12 bit 
and video quality menu set to 12 bit, and you performed a playback from Frame View, made an 
edit in Trim mode and exit, or selected Source Settings and then exited, you received a “Two 
Exception:Tee build” error. 

➤ Bug Number: MCDEV-3971. The resulting image was distorted when you used the Spot Color 
Correction effect with a shape tool.

➤ Bug Number: MCDEV-3885. (Artist DNxIO).You might have experienced dropped frame 
when playing back 1 Stream of 4K 59.94P AMA XAVC-I in full resolution 8-bit.

New in Media Composer v8.4.1
• Media Composer v8.4.1 includes support for Mac OS X v10.10.4 and v10.10.5

• Media Composer v8.4.1 includes support for Avid Artist DNxIO hardware. For information 
on setting up the Avid Artist DNxIO hardware, see the Avid Artist DNxIO Setup Guide here.

n Bug Number: BMD-56. When using the Avid Artist DNxIO, the LCD screen might not be 
functional after a firmware update. If this occurs, shut down your workstation and remove A/C 
power from Artist DNxIO. Reconnect A/C power to the Artist DNxIO and power up your 
workstation.

http://www.avid.com/onlinesupport
http://avid.force.com/pkb/articles/en_US/User_Guide/Avid-Artist-DNxIO-Documentation
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Fixed in v8.4.1

The following have been fixed in Media Composer v8.4.1:

➤ Bug Number: MCCET-771. In some instances, importing XDCAM media from an earlier 
version of the editing application, did not playback in the editing application.

➤ Bug Number: MCCET-769. When working with Media Composer | Cloud, using the J key to 
play footage resulted in an “APanVolConsumer::GetAutoGain” error.

➤ Bug Number: MCCET-734. Pressing the Num Lock key multiple times might have resulted in 
crashing the editing application.

➤ Bug Number: MCCET-717. Text appeared corrupted after rendering a rolling title. 

➤ Bug Number: MCCET-710. In some instances, descending letters such as g, p, y in Subcap 
titles are cut off. 

➤ Bug Number: MCCET-707.  “Add item” in the Send To > Make New > Auto Launch did not 
work in Simplified Chinese.

➤ Bug Number: MCCET-702. Performing an audio punch in with “remove extra filler after 
punch-in” enabled and pre/post handles enabled resulted in a lost dissolve or crash.

➤ Bug Number: MCCET-619.  Playing back MPEG4 QuickTime resulted in the first frame 
displaying as the last frame.

➤ Bug Number: MCCET-649. RAM would fill and the system would slow down when linking to 
AVCHD files.

➤ Bug Number: MCCET-489. Adding a Marquee Script to a title crashed the Marquee title tool.

➤ Bug Number: MCCET-428.  Performing a Recreate Title Media did not always recreate all the 
titles.

➤ Bug Number: MCCET-406. If you transcode a sequence or a subclip, it ignores the parameters 
and transcodes the entire master clip. You will now receive a warning message to either 
transcode the full clip, or create a new clip with the assigned parameters.

➤ Bug Number: MCCET-314. In some instances, the Avid Artist Control surface jog wheel did 
respond when turning it slowly.
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➤ Bug Number: MCCET-294. You could not AMA link to Air Speed 5000 MXF files.

➤ Bug Number: MCDEV-3647. In some instances, trim changes did not apply if you performed a 
trim quickly.

➤ Bug Number: MCCET-134. You might have received an ilok licensing error when launching 
the editing application.

➤ Bug Number: MCCET-666. Performing audio scrub with XDCAM media was slow to respond.

➤ Bug Number: MCCET-548. After consolidating an exported AAF sequence, renders were lost.

➤ Bug Number: MCCET-671.  Accessing an AMA media folder from the AMA link dialog box 
and then moving back out of a folder took a long time if there were many subfolders on the 
shared directory.

➤ Bug Number: MCCET-430. With the Get Info window open, performing some operations 
would crash the editing application.

➤ Bug Number: MCCET-681. In some instances, the Send To Playback Temp folder on a 
workspace was filling up over time.

➤ Bug Number: MCCET-725. Audio effects saved to a bin did not apply after quitting out of the 
editing application.

➤ Bug Number: MCCET-118. AAFs created from the Sony PDZ Content Browser software 
would not relink properly. 

➤ Bug Number: MCCET-642. If Clip frames were enabled in the Timeline, the editing application 
was slow to respond.

➤ Bug Number: MCCET-688. In some instances, consolidating a sequence consolidated an entire 
source clip’s duration rather than just the amount used in the sequence. This added size to the 
consolidated media folder.
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New in Media Composer v8.4

For information on new features, see the What’s New v8.4. 

NVIDIA Driver Qualification - Avid has qualified v347.52 driver. 

This driver is not compatible with older Graphics cards from the Quadro FX series; the 3700, 
3800 and 4800. For these cards, remain on driver 340.84.

c Any customer that has previously activated a v8 license will need to re-activate their 
current license when they want to upgrade to Media Composer v8.3 or higher. Dongle 
customers will also need to re-update their dongle. For more information, please see the 
Media Composer Support Contract License Update FAQ knowledge base article.

Fixed in Media Composer v8.4

The following were fixed in v8.4:

➤ Bug Number: MCCET-676. When a Subcap outline effect started with certain capital letters, it 
did not display properly.

➤ Bug Number: MCCET-483. Subcaps did not import Greek captions correctly.

➤ Bug Number: MCCET-40. You could not select “No Tracker” when performing four point 
tracking.

➤ Bug Number: MCCET-558. Video output did not change when toggling sources using the Esc 
key and the viewers were minimized.

➤ Bug Number: MCCET-691. In some instances, you might have seen dropped frames during 
playback of LongGOP media.

➤ Bug Number: MCCET-699. Bengali fonts did not display correctly in the NRCS tool.

➤ Bug Number: MCCET-305. In some configurations, you might have experiences skipped 
frames when connected to ISIS storage.

➤ Bug Number: MCCET-537. The editing application did not retain the Aspect Ratio for an Edit 
While Capture clip.

➤ Bug Number: MCCET-677. You might have received an “Assertion failed” error when using 
Segment Mode with sequence loaded into the Clipboard Monitor.

http://avid.force.com/pkb/articles/en_US/readme/Media-Composer-Software-8-0-Documentation
http://avid.force.com/pkb/articles/en_US/faq/Media-Composer-Software-Born-On-Date-Licensing-FAQ
http://avid.force.com/pkb/articles/en_US/faq/Media-Composer-Software-Born-On-Date-Licensing-FAQ
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➤ Bug Number: MCCET-571. (Interplay) When performing a Check into Interplay, the Property 
Merge dialog box did not display in the editing application.

➤ Bug Number: MCCET-532. Performing an Edit While Capture with XDCAM media did not 
update properly in the editing application.

➤ Bug Number: MCCET-158. The original project was updated when you performed an edit on a 
duplicate project.

➤ Bug Number: MCCET-422. When adding a Color Correction preset, the editing application 
would crash.

➤ Bug Number: MCCET-640. (Interplay) With Show Target Availability selected, Timeline text 
appeared corrupted.

➤ Bug Number: MCCET-690. In some instances, even if you selected “Override working settings 
with target settings” the material would display as offline. The media now displays online.

➤ Bug Number: MCCET-528. When performing an Undo after a replace edit, the blue bar did not 
return to the position in source monitor.

➤ Bug Number: MCCET-539. In some instances, AS-11 exports failed.

➤ Bug Number: MCCET-492.  Play stuttered when playing backward using the J key in a 25 fps 
project.

➤ Bug Number: MCCET-691. In some instances, you might have seen dropped frames during 
playback of LongGOP media.

➤ Bug Number: MCCET-549. In some instances, audio mapping for stereo clips on the Timeline 
were not mapping correctly.

➤ Bug Number: MCCET-550. If Hyperthreading was On, AVC-I 100 PAL playback stuttered.

➤ Bug Number: MCCET-336. (Mac) If you changed the OS to Chinese, some AudioSuite 
plug-ins were grayed out or missing.

➤ Bug Number: MCCET-531. (Macintosh) In an Interplay environment, the editing application 
would crash intermittently when performing various operations.

➤ Bug Number: MCCET-606. After saving a story in the NRCS Tool, some characters such as 
“<< >>” and “&” did not display correctly.
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➤ Bug Number: MCCET-100. If you had Media Services set as a Site Setting, the “Use STP 
Encode” option would not be available on new projects.

➤ Bug Number: MCCET-402.  Occasionally, background render did not work if you were 
working in a Japanese OS.

➤ Bug Number: MCCET-569. (Interplay) You might have received “Core Consistency Check 
Failure” errors if you added clip gain to the clip while it was currently ingesting and then 
scrubbed.

➤ Bug Number: MCCET-608. The editing application would crash when importing files with 
120+ characters in the file name.

➤ Bug Number: MCCET-258. Information in the video ID column was truncated and did not 
display properly in the NRCS Tool.

➤ Bug Number: MCCET-526. Intermittently, MultiCam playback was not always accurate at edit 
points.

➤ Bug Number: MCCET-144. You received an “Audio Export File Too Large” error when 
exporting a WAV file that exceeded 2GB in size.

➤ Bug Number: MCCET-503.  In an Interplay environment, loading a sequence, in some 
instances, took longer than usual.

➤ Bug Number: MCCET-340. Center aligned SubCaps did not wrap lines properly.

➤ Bug Number: MCCET-429. When promoting a title from the Title Tool to Marquee, Chinese 
characters might have appeared unrecognizable.

➤ Bug Number: MCCET-516. Recreated deleted titles might have displayed special characters as 
question marks or random characters.

➤ Bug Number: MCCET-211. In some instances, when reimporting or AMA linking files, the 
audio tracks were repositioned.

➤ Bug Number: MCCET-511. In an Interplay environment, checking sequences in and out took 
longer than usual.

➤ Bug Number: MCCET-557. Markers on Data track previously did not import back into Media 
Composer.
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➤ Bug Number: MCCET-195. In some instances, large sequences with audio waveforms enabled 
did not cache properly. 

➤ Bug Number: MCCET-521. J2k linked media appeared as “Unsupported” in the Video column.

➤ Bug Number: MCCET-543. In some instances, performing a Send to Playback from Media 
Composer | Cloud sent the proxy media to playback. For remote clients, the Dynamic Relink 
target setting is set to Prefer Native. The application will try and relink to native media. If not, it 
will try and relink to AMA media. It will not send proxy media to playback.

➤ Bug Number: MCDEV-2938. With Black Magic Design (BMD) active, the editing application 
crashes when switching from UHD 60p to 1080p 60.

➤ Bug Number: MCDEV-3005. Apple® ProRes images in Flat 2K and Flat 4K projects are 
corrupt.

➤ Bug Number: MCCET-525. When linked to WAV or MP3 files, there were audible clicks near 
cuts during playback.

➤ Bug Number: MCCET-518. In some instances, a LUT did not stay applied to multi-resolution 
clips.

➤ Bug Number: MCCET-605. In some instances, you might have received a “badthingvalue” 
error when exporting as AAF.

➤ Bug Number: MCCET-538.  In some instances, imported monophonic Broadcast Wave files 
ignored track numbers.

➤ Bug Number: MCCET-595. The system might have crashed if you decreased the video track 
size when Clip Frames was enabled in the Timeline fast menu.

➤ Bug Number: MCCET-513. Playing back clips with resolutions listed in the DisabledRes.txt 
file resulted in an “unsupported resolution” error. You should be able to playback resolutions 
listed in this text file.

➤ Bug Number: MCCET-514. In some instances, the editing application crashed when opening a 
script file.

➤ Bug Number: MCCET-444.  An incoming EVS clip resulted in white noise when editing close 
to the incoming clip boundary.

➤ Bug Number: MCCET-92.  You might have received “An error occurred on event #” message 
when importing an ALE if there was a greater than 12 hour timecode gap between clips.
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➤ Bug Number: MCCET-89.  Using the click-and-drag method for creating a bezier with the 
Animatte effect was not working.

➤ Bug Number: MCDEV-510. With a Matrox MX02 attached, you might have experienced 
dropped frames when playing back XDCAM Multicam. 

➤ Bug Number: . When performing color correction with the Filmlight® Baselight plug-in effect, 
the client monitor now updates properly.

➤ Bug Number: MCDEV-2565. Audio tracks numbered higher than 4 were not added into List 
Tool output.

Before Installing the Editing Application
Media Composer Release Date

With the December 2014 release of Media Composer v8.3, Avid Advantage Upgrade & Support 
plan information will be included in a customer's Media Composer license. In addition, each 
build (release) of Media Composer will be marked with its release date. Media Composer will 
compare the active contract dates in the license to the release date of the software to ensure they 
are compatible. If the release date is within the contract dates, the software will run; if it is 
outside the contract dates (i.e. the contract has expired), the software will not run. For more 
information, please see the Media Composer Support Contract License Update FAQ knowledge 
base article.

n This does not apply to subscriptions of Media Composer. Software subscriptions require a check 
every 30 days to ensure upgrade eligibility, therefore including the support dates on a 
subscription license is not required.

Application Manager and Media Composer Compatibility

A licensing database is created when you first launch Media Composer or when you first launch 
Application Manager. With the release of Application Manager v2.2 and Media Composer v8.3, 
the way in which the licensing database was created changed. Media Composer v8.3 is 
compatible with Application Manager v2.2. However, if you update to Application Manager 
v2.2 and attempt to launch a version of Media Composer prior to v8.3 and you had deleted the 
license database before launching Application Manager v2.2, the editing application will not 
launch. If you experience this, you can do one of the following:

• Uninstall Application Manager v2.2. Uninstall and Reinstall the Media Composer version 
(prior to v8.3). The earlier version of the editing application will install a compatible 
Application Manager.

• Upgrade to Media Composer v8.3 or higher. 

http://avid.force.com/pkb/articles/en_US/faq/Media-Composer-Software-Born-On-Date-Licensing-FAQ
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Installation Information

Read through the Installation Guide for Avid Editing Applications. This document is available on 
the Knowledge Base. 

If you are upgrading from v7.x to v8.x, you must uninstall the Avid Transcode Service and the 
Avid Editing application. Beginning with version 8.0 of the editing application, the Transcode 
Service is included as part of the editing application and is no longer a separate program. When 
you uninstall Media Composer v8.0, a separate uninstall of Transcode service is no longer 
necessary.

Buffer Error Message

The editing application requires a minimum of 8GB RAM. If you try to install the editing 
application on a system with less than 8GB RAM, you will receive a buffer error and installation 
will not proceed.

Supported Systems Message

A new message has been added to this release that detects if you are installing on an unsupported 
system: “Your system does not support this version of Media Composer | Software. Please 
consult the Specifications information on Avid.com for supported configurations. Media 
Composer | Software installation will be aborted.”

Media Composer 8.3 and newer systems require a micro architecture that supports the SSE 4.1 
CPU Instruction set. Most systems shipped since 2008 with four or more processor cores, i.e. 
Quad core, will include this functionality. Systems shipped before 2008 are not likely to support 
this functionality and Media Composer will fail to install. 

If you receive the message, go here to review system requirements.

Sentinel Error Message

(MCDEV-2394) On a Windows 7 system, if a “Failed to add Sentinel64.cat file.” error appears 
during the installation, you can safely click OK to continue with the installation. Dongle 
activation will work properly.

Download Note

To avoid “File Path too long” or a “File cannot be copied” warning while unzipping the 
downloaded installer, try placing the installer .zip on the root level of your C:\ drive and unzip it 
from that location.

http://www.avid.com/US/products/media-composer#specifications
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User Right to Raise Thread Priority

(Windows) Note for Domain Administrators: If your editing systems are part of a domain, you 
must give the user the right to “Increase Scheduling Priority.” This must be done within the 
Domain Group Policy on the domain controller by giving the right explicitly to the user or giving 
the right to a group and adding the user to that group. You will not be able to launch as a regular 
user if this is not set properly.

If you are part of a domain, a Domain Administrator should install and perform the first launch 
of the editing application.

Install as Administrator

You need to first install and launch the editing application as an Administrator. If you are in a 
Shared Storage environment, mount your workspaces as an Administrator. You may then log off 
and log back in as a Standard user, if necessary.

After Installing the Editing Application
AMA Plug-Ins

You cannot install the AMA Plug-ins while the editing application background services are 
running. Make sure you Stop the services before installing the AMA Plug-Ins. The stop/start 
background services icon is on the menu bar (Macintosh) or taskbar (Windows). Once you install 
the new AMA plug-in, restart the services. See “Starting and Stopping Avid Background 
Services” in the Help.

Notes on Windows

Note the following topics if you are running the editing application on the Windows OS.

Disabling Desktop Compositing

When the Avid editor is launched you might see a dialog box asking you to disable desktop 
compositing. You can disable it without adversely affecting the Avid editing application.

You can choose to disable it and continue with your editing session. The dialog will appear once 
you relaunch the application unless you disable the option.

To disable the desktop compositing:

1. Access the Control Panel.

2. Double-click System.
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3. Click Change Settings.

4. Click the Advanced tab.

5. Under the Performance area, click Settings. 

6. Uncheck “Enable desktop composition.”

The dialog box requesting you to disable desktop compositing does not appear the next time 
you launch the editing application. 

Notes on Software Licensing

If You Upgrade Your Operating System

If you need to upgrade your operating system after you install your Avid editing application, first 
deactivate your software. After you upgrade your operating system and, if required, reinstall 
your application, you can reactivate your software. For information on activating and 
deactivating your software license, see the Installation Guide for Avid Editing Applications.

Minimum RAM Recommendation

For this release Avid recommends a minimum of 8GB of RAM. Some features might require 
more RAM and specific hardware. See “Feature Performance” on page 24 for more info.

Qualified Hardware and Operating Systems

Some features are processor-intensive and require specific hardware. See “Feature Performance” 
on page 24 for more info.

The following tables provide the information on qualified Windows and Macintosh hardware. 

For 3rd-Party Open IO hardware qualification refer to the manufacturer’s documentation. See the 
Open IO Frequently Asked Questions document on the Knowledge Base: 
http://avid.force.com/pkb/articles/en_US/faq/en422991

The following tables also list the qualified Operating Systems. Depending upon your hardware 
the qualified Operating Systems are:

• Windows v7 64-bit SP1(Professional) and Windows v8.1 (Professional and Enterprise)

• Macintosh v10.9.5, v10.10.1, v10.10.2, v10.10.3, v10.10.4, v10.10.5

http://avid.force.com/pkb/articles/en_US/faq/en422991
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Macintosh OS Permission Information

As of Macintosh OS 10.7 Lion, the default permissions for the root level of the system drive are 
now set to “Read Only” for all users. This prevents the Avid Editing Application from being able 
to use this drive as a media drive. You will see the drive grayed out in Media Creation settings or 
as an option for import, mixdown, render, and consolidate/transcode.

If you don’t intend to use the system drive for media you can leave it alone. This is ideal in most 
cases.

If you do need to use the system drive, perform the following to change permissions.

To change permissions:

1. Click on your system drive (Macintosh HD in most cases) to highlight.

2. From the File menu select Get Info (cmd+I)

3. Click the lock icon in the bottom right to make changes

4. Click on the “Read only” text in the Privilege column next to Everyone and set the privilege 
to “Read & Write”

You should now be able to see the system drive as a valid media drive.

n If you repair permissions on the system drive, they will reset and you will have to repeat this 
procedure.

Qualified Workstations and Laptops

The following tables list the qualified workstations and laptops for Media Composer editing 
applications.

Qualified PC Workstations with Avid Media Composer

The following PC Workstations are qualified with Avid Media Composer.

Qualified PC Hardware Graphics Card Supported with 

HP Z840 Dual [6, 8, or 12 core 2.3 Ghz or 
higher]

16/32/64 GB DDR4-2133 memory

NVIDIA K4200 or 
K5200
AMD W7100 or 
W8100

Software Only
Nitris DX
Mojo DX
Artist DNxIO 

HP Z640 Dual [6, 8, or 12 core 2.3 Ghz or 
higher]

16/32/64 GB DDR4-2133 memory

NVIDIA K4200 or 
K5200
AMD W7100 or 
W8100 or W5100

Software Only
Nitris DX
Mojo DX
Artist DNxIO 
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Dell 7910 Dual [6, 8, or 12 core 2.3 Ghz or 
higher]

16/32/64 GB DDR4-2133 memory

NVIDIA K4200 or 
K5200
AMD W7100 or 
W8100

Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Dell 7810 Dual [6, 8, or 12 core 2.3 Ghz or 
higher]

16/32/64 GB DDR4-2133 memory

NVIDIA K4200 or 
K5200
AMD W7100 or 
W8100 or W5100

Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Lenovo P900 Dual [6, 8, or 12 core 2.3 Ghz or 
higher]

16/32/64 GB DDR4-2133 memory

NVIDIA K4200 or 
K5200

Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Lenovo P700 Dual [6, 8, or 12 core 2.3 Ghz or 
higher]

16/32/64 GB DDR4-2133 memory

NVIDIA K4200 or 
K5200

Software Only
Nitris DX
Mojo DX
Artist DNxIO 

HP Z820 Dual 6-core E5-2630V2 2.6 Ghz, 8 
core E5-2650V2 2.6 Ghz, or 12 core E5-2695V2 
2.4 Ghz 16/32 GB DDR3-1866 memory

K4000 Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Dell T7610 Dual 6-core E5-2630V2 2.6 Ghz, 8 
core E5-2650V2 2.6 Ghz, or 12 core E5-2695V2 
2.4 Ghz 16/32 GB DDR3-1866 memory

K4000 Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Dell T5610 Dual 6-core E5-2630V2 2.6 Ghz, 8 
core E5-2650V2 2.6 Ghz, or 12 core E5-2695V2 
2.4 Ghz 16/32 GB DDR3-1866 memory

K4000 Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Lenovo D30 Dual 6-core E5-2630V2 2.6, 8 core 
E5-2650V2 2.6, or 12 core E5-2695V2 2.4 
16/32 GB DDR3-1866 memory

K4000 Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Lenovo C30 Dual 6-core E5-2630V2 2.6, 8 core 
E5-2650V2 2.6, or 12 core E5-2695V2 2.4 
16/32 GB DDR3-1866 memory

K4000 Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Qualified PC Hardware Graphics Card Supported with 
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HP z820 Dual 8 Core Intel Xeon E5-2665 2.4 
GHz, Quad 6-core E5-2640 2.5 GHz

NVIDIA Q4000 or 
K4000

Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Lenovo D30 Dual 6 core E5-2640 2.5Ghz or 
Dual 8 core E5-2660 2.2 GHz 16 GB 
DDR3-1600 memory

NVIDIA Q4000 or 
K4000

Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Lenovo C30 Dual 6 core E5-2640 2.5GHz or 
Dual 8 core E5-2660 2.2 GHz 16 GB 
DDR3-1600 memory

NVIDIA Q4000 or 
K4000

Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Dell T7600 Dual 8 core Intel E5-2665 2.4 GHz 
16 GB DDR3-1600 memory, Dual 6-core 
E5-2630

NVIDIA Q4000 or 
K4000

Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Dell T5600 Dual 6-core Intel E5-2630 2.2 GHz 
16 GB DDR3-1600 memory, Dual 8-core 2665

NVIDIA Q4000 or 
K4000

Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Lenovo ThinkStation E31, Intel Xeon 
E3-1245V2 3.40 GHz 8 GB DDR3-1600 RAM

NVIDIA Q600 or 
K600 HD4000

Software Only

HP z800 Dual 6 Core, 2.66 GHz NVIDIA
FX Quadro 3800 
and Q4000

Software Only
Nitris DX
Mojo DX
Artist DNxIO

HP Z440 6 or 8 core 3.0 Ghz or higher]

16/32 GB DDR4-2133 memory

NVIDIA K2200
AMD W5100

Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Dell 5810 6 or 8 core 3.0 Ghz or higher]

16/32 GB DDR4-2133 memory

NVIDIA K2200
AMD W5100

Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Lenovo P500 6 or 8 core 3.0 Ghz or higher]

16/32 GB DDR4-2133 memory

NVIDIA K2200 Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Qualified PC Hardware Graphics Card Supported with 
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HP Z420 6-core E5-1650 V2 3.5 Ghz 8/16 GB 
DDR3-1866 memory

NVIDIA K2000 Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Dell T3610 6-core E5-1650 V2 3.5 Ghz 8/16 GB 
DDR3-1866 memory

NVIDIA K2000 Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Lenovo S30 6-core E5-1650V2 3.5 Ghz 8/16 
GB DDR3-1866 memory

NVIDIA K2000 Software Only
Nitris DX
Mojo DX
Artist DNxIO 

HP z420 6-core Intel E5-1650 3.2 GHz 8 GB 
DDR3-1600 memory

NVIDIA Q2000 or 
K2000

Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Lenovo S30 6-core Intel E5-1650 3.2 GHz 8 GB 
DDR3-1600 memory

NVIDIA Q2000 or 
K2000

Software Only
Nitris DX
Mojo DX
Artist DNxIO 

Dell T3600 6-core Intel E5-1650 3.2 GHz 8 GB 
DDR3-1600 memory

NVIDIA Q2000 or 
K2000

Software Only
Nitris DX
Mojo DX
Artist DNxIO 

HP z400 Single 6 Core 3.33 GHz NVIDIA 
Quadro FX 3800
Quadro 2000

Software Only
Nitris DX
Mojo DX
Artist DNxIO

Dell™ T5500 Dual 6 Core, 2.66GHz NVIDIA
Quadro FX 4800
Quadro 4000

Software Only
Nitris DX
Mojo DX

Dell T3500 Single 6 Core, 3.2GHz NVIDIA 
Quadro FX 3800
Quadro 2000

Software Only
Nitris DX
Mojo DX

HP Z230 quad  Xeon E3-1245V3 3.4 Ghz

8/16 GB DDR3-1600 memory   Tower or SFF

K600

HD4600

Software Only

Qualified PC Hardware Graphics Card Supported with 
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Qualified PC Notebooks for Avid Media Composer

The following PC Notebooks are qualified with Avid Media Composer. The following applies to 
the editing system when running on a laptop:

• DNxHD capture is only supported on Mojo DX on a Quad core system with hyperthreading 
enabled. Nitris DX is not supported on laptops.

• Capture of 10 bit video for example, DNxHD 185x, is not supported on Mojo DX.

• Playback in full quality 10 bit mode is not supported

Lenovo P300 quad Xeon E3-1246V3 3.5 Ghz

8/16/32 GB DDR3-1600 memory   Tower or 
SFF

K600 or K620

HD4600

Software Only

Lenovo E32 quad Xeon E3-1245V3 3.4 Ghz

8/16 GB DDR3-1600 memory   Tower or SFF

K600

HD4600

Software Only

Dell T1700 quad Xeon E3-1245V3 3.4 Ghz

8/16 GB DDR3-1600 memory   Tower or SFF

K600

HD4600

Software Only

HP Z1 G2 All-in-one  E3-1245V3 3.4 Ghz

8/16 GB DDR3-1600 memory   Thunderbolt

K2100M

Intel HD4600

Mojo DX 

Software Only

Lenovo ThinkCentre Edge 93Z  i7-4770S 3.1 
Ghz 8/16 GB DDR3-1600 memory     quad core 
All-in-One

Intel HD4600 Software Only

HP Z220 Quad Xeon E3-1245V2 3.4 GHz 8 GB 
DDR3-1600 memory   (Tower or SFF)

Q600 or K600

HD4000

Software Only

HP Z1 Quad Xeon E3-1245V2 3.4 GHz 8 GB 
DDR3-1600 memory   All-in-One

NVIDIA K1000M 
or HD4000

Software Only

Lenovo ThinkCentre Edge 92Z  i7-3770S 3.1 
Ghz 8 GB DDR3-1600 memory     Quad core 
All-in-One

Intel HD4000 Software Only

Qualified PC Hardware Graphics Card Supported with 

Qualified PC Notebooks Graphics Cards Supported With

HP Zbook 14" 2.1 Ghz dual core i7-4600U 
1920x1080 - 8/16 GB 1600Mhz DDR3 
Memory Ultrabook

Intel HD4400 
FirePro M4100

Software Only
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HP Zbook 15" G2 - 2.5 Ghz and higher quad 
core i7 1920x1080 - 8/16/32 GB 1600Mhz 
DDR3 Memory thunderbolt

K1100M

K2100M

Software Only
Mojo DX
Artist DNxIO 

HP Zbook 15" 2.4 Ghz and higher quad core i7 
1920x1080 - 8/16 GB 1600Mhz DDR3 
Memory thunderbolt

K1100M

K2100M

Software Only
Mojo DX
Artist DNxIO 

HP Zbook 17" G2 - 2.5 Ghz and higher quad 
core i7

1920x1080 - 8/16/32 GB 1600Mhz DDR3 
Memory thunderbolt

K3100M

K4100M

K2200M

Software Only
Mojo DX
Artist DNxIO 

HP Zbook 17" 2.4 Ghz and higher quad core i7

1920x1080 - 8/16 GB 1600Mhz DDR3 
Memory thunderbolt

K3100M

K4100M

Software Only
Mojo DX
Artist DNxIO 

Dell M3800 15" 2.2 Ghz and higher quad core 
i7 1920x1080 or 3200x1800 - 8/16/32 GB 
1600Mhz DDR3 Memory   Ultrabook

K1100M

K2100M

Software Only
Mojo DX
Artist DNxIO 

Dell M4800 15" 2.4 Ghz and higher quad core 
i7 1920x1080 or 3200x1800 - 8/16/32 GB 
1600Mhz DDR3 Memory

K1100M

K2100M

Software Only
Mojo DX

Dell M6800 17" 2.4 Ghz and higher quad core 
i7 1920x1080 - 8/16/32 GB 1600Mhz DDR3 
Memory

K3100M

K4100M

Software Only
Mojo DX

Lenovo W541 15" 2.4 Ghz and higher quad 
core i7 15" 1920x1080 2880x1620 - 8/16/32 
GB 1600Mhz DDR3 Memory Thunderbolt

K1100M

K2100M

Software Only
Mojo DX

Lenovo W540 15" 2.4 Ghz and higher quad 
core i7 15" 1920x1080 2880x1620 - 8/16 GB 
1600Mhz DDR3 Memory Thunderbolt

K1100M

K2100M

Software Only
Mojo DX
Artist DNxIO 

Lenovo ThinkPad W530
"Intel Core i7-3720QM 2.6 GHz, i7-3820QM 
2.7GHz, i7-3920XM 2.9GHz 

NVIDIA Quadro 
K1000M or 
K2000M 

Software Only
Mojo DX

HP 8770w i7-3720QM 2.6 Ghz, I7-3820QM 
2.7Ghz, I7-3920XM 2.9GHz 17" 1920x1080 - 
8 GB 1600MHz DDR3 Memory

NVIDIA Quadro 
K3000M or 
K4000M

Software Only
Mojo DX

Qualified PC Notebooks Graphics Cards Supported With
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Qualified Macintosh Workstations for Avid Media Composer

The following Macintosh Workstations are qualified with the Avid Media Composer. 

HP 8570w I7-3720QM 2.6GHz, i7-3820QM 
2.7 GHz 15" 1920x1080 - 8 GB 1600Mhz 
DDR3 Memory

NVIDIA Quadro 
K1000M or 
K2000M 

Software Only
Mojo DX

Dell M6700 i7-3740QM  2.7 GHz 17" 
1920x1080 - 8 GB 1600Mhz DDR3 Memory

NVIDIA Quadro 
K3000M or 
K4000M

Software Only
Mojo DX

Dell M4700 i7-3740QM  2.7 GHz, 15" 
1920x1080 - 8 GB 1600Mhz DDR3 Memory

NVIDIA Quadro 
K1000M or 
K2000M

Software Only
Mojo DX

HP 8760w i7-2720Q, i7-2820Q 2.2 or 2.3 GHz NVIDIA
Quadro 3000M
Quadro 4000M

Software Only
Mojo DX

HP 8560w, i7-2720Q, 2820Q, 2.2 or 2.3 GHz
17” 1920 x1080

NVIDIA
Quadro 1000M
Quadro 2000M

Software Only

Dell M6600, i7-2720Q, 2820Q, 2.2 or 2.3 GHz
17” 1920 x1080

NVIDIA
Quadro 3000M
Quadro 4000M

Software Only
Mojo DX

Dell M4600, i7-2720Q, 2820Q, 2.2 or 2.3 GHz
15” 1920 x1080

NVIDIA
Quadro 1000M
Quadro 2000M

Software Only
Mojo DX

Qualified PC Notebooks Graphics Cards Supported With

Qualified Macintosh Hardware Graphics Cards Supported With

Mac Pro 6 core 3.5 Ghz, 8 core 3.0 Ghz, 12 
core 2.7 (Late 2013) 16/32 GB 1866Mhz 
DDR3 Memory Thunderbolt - no PCI-e slots

AMD FirePro D500 Software Only
Mojo DX 
Nitris DX (no HD capture)
Artist DNxIO 

Mac Pro “Westmere” Two 2.66GHz 6-Core 
Intel Xeon (12 cores) 

ATI Radeon HD 5770 Software Only
Nitris DX
Mojo DX
Artist DNxIO 
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Qualified Macintosh Notebooks for Media Composer

The following Macintosh notebooks are qualified with the current editing applications. The 
following applies to the editing system when running on a laptop.

• HD Capture on Macintosh notebooks is not supported

• Playback in full quality 10 bit mode is not supported

iMac Retina 5K 27" 4.0 Ghz i7 Quad core

Late 2014 - 8/16/32 GB 1600Mhz DDR3

Radeon M290X, 
M295X

Software Only
Mojo DX 
Artist DNxIO 

iMac 27" 3.2,3.4 GHz i5 or 3.5 Ghz i7 Quad 
core Late 2013 - Thunderbolt - 8/16 GB 
1600Mhz DDR3

GeForce GTX 775 Software Only
Mojo DX 
Artist DNxIO 

iMac 21.5" 2.9 GHz i5  or 3.1 Ghz i7 Quad 
core Late 2013 - Thunderbolt - 8/16 GB 
1600Mhz DDR3

GeForce GT 750 Software Only
Mojo DX 
Artist DNxIO 

iMac 27” 2.9GHz Quad-core Intel i5, 3.2Ghz 
Quad-core Intel i5, 3.4 GHz Quad Core Intel 
i7 (Late 2012)

NVIDIA GeForce 
GTX 660M or 
NVIDIA GeForce 
GTX 675MX

Software Only
Mojo DX 
Artist DNxIO 

iMac 21.5” 2.9GHz Quad-core Intel i5, 
3.1GHz Quad-core Intel i7 (Late 2012)

NVIDIA GeForce 
650M

Software Only
Mojo DX 
Artist DNxIO 

iMac 27” Display Quad Core 3.4 GHz (Mid 
2011)

ATI 6970M Software Only
Mojo DX 
Artist DNxIO )

Mac mini 2.3/2.6GHz quad core Intel i7 Intel HD 4000 Software Only
Mojo DX 
Artist DNxIO 

Mac Mini Server 2.0 GHz i7 Quad core 
Thunderbolt - 4GB 1333MHz DDR3

Intel 
3000

Software Only
Mojo DX 
Artist DNxIO 

Qualified Macintosh Hardware Graphics Cards Supported With



Qualified Hardware and Operating Systems

23

Qualified Macintosh Notebook Graphics Cards Supported With

MacBook Air 13"  - 1.7 Ghz and higher i7 
Dual-Core (Mid 2013) - Thunderbolt - 8 GB 
1600Mhz DDR3L

Intel HD5000 Software Only
Mojo DX 

MacBook Air 13"  - 2.0 GHz I7 Dual-Core 
Thunderbolt - 8 GB 1600MHz DDR3L

Intel HD4000 Software Only
Mojo DX 

MacBook Pro 15" 2.3/2.6/2.7 GHz I7 (Late 
2013) Quad-Core - Retina & Thunderbolt

8 GB 1600Mhz DDR3L Memory

HD5000

GeForce GT 750M

Software Only
Mojo DX
Artist DNxIO 

MacBook Pro 15" 2.3/2.6/2.7 GHz I7 
(Mid/Late 2012) Quad-Core - Retina & 
Thunderbolt

8 GB 1600Mhz DDR3L Memory

HD4000

GeForce GT 650M

Software Only
Mojo DX 
Artist DNxIO

MacBook Pro 17" 
2.2/2.3/ GHz Quad Core i7

6750M
Intel 
3000

Software Only
Mojo DX 
Artist DNxIO 

MacBook Pro 15" 
2.0/2.2/2.3GHz Quad Core i7

6490M
6750M
Intel 
3000

Software Only
Mojo DX 
Artist DNxIO 
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Feature Performance

A number of features in this editing application are processor-intensive. As a result, you might 
experience problems if you are working on an older system. The following chart shows the 
hardware that Avid has successfully qualified when using these features. For a list of the 
qualified systems, see Qualified Workstations and Laptops. 

Feature Description Recommended System

Editing High Resolution, 
High Frame Rate Media 
(UHD/4k in 59.94p) 

16 GB RAM minimum, 32 GB 
recommended

HP Z820, HP Z840, Dell 7810, Dell 
7910, Lenovo P900, Lenovo P700

• Dual 8 core (32 cores with 
Hyperthreading), 

• Dual 10 core (40 cores with 
Hyperthreading),

• Dual 12 core (48 core with 
Hyperthreading) 

• NVIDIA 5200 PCIe Gen3 Gfx card 
(recommended)

• NVIDIA 4200

Mac Pro 

• 12 core (24 with Hyperthreading) 
3 GHz

• Dual AMD FirePro 500/700 Graphics 
card

Storage: 10Gb Ethernet ISIS

Editing High Resolution 
Media (Higher than 2K+)

16 GB RAM minimum Qualified PC Dual 6 Core or higher 

Qualified Mac Pro 6 core or higher, 12 
core with Hyperthreading

DMF and Background 
Transcode, Background 
Render

8 GB RAM minimum. 16 GB 
RAM recommended

Qualified PC Dual 6 Core or higher 

Qualified Mac Pro 6 core or higher, 12 
core with Hyperthreading

Media Composer | Cloud 16GB RAM minimum. 24 GB or 
higher recommended depending 
upon system model.

i7 Quad core or higher with 
Hyperthreading
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J2K Capture Qualified PC Dual 6 Core or higher 

Qualified Mac Pro 6 core or higher, 12 
core with Hyperthreading

HD Long GOP 9-way 
MultiCam with high 
stream count sequences

Avid recommends 16 GB RAM Qualified PC Dual 6 Core or higher 

Qualified Mac Pro 6 core or higher, 12 
core with Hyperthreading

Storage: 10Gb Ethernet ISIS, 

Stereoscopic 3D For optimal performance with 
Stereoscopic 3D, use these higher 
performance systems. Avid 
recommends a minimum of 12GB 
RAM when using Stereoscopic 
3D.

Qualified PC Dual 6 Core or higher 

Qualified Mac Pro 6 core or higher, 12 
core with Hyperthreading

XDCAM HD50 Capture Baseband capture through Nitris 
DX, Mojo DX

Qualified systems

HD RGB 4444
Apple ProRes 4444
DNxHD 4444

HD RGB capture requires a high 
end workstation with Nitris DX 
and fast storage. 

Qualified PC Dual 6 Core or higher 

Qualified Mac Pro 6 core or higher, 12 
core with Hyperthreading

Storage: 10Gb Ethernet ISIS, 

AMA (RED) AMA is a processor intensive 
operation. Older platforms may 
not offer optimum performance. 
you will get better performance 
with higher end workstations.

Qualified Xeon Workstations

AMA (QuickTime) AMA is a processor intensive 
operation. Lower end platforms 
may not offer optimum 
performance. Highly compressed 
codecs such as H.264 will exhibit 
minimal real-time performance. 

Recommendation of qualified systems 
depends on your planned use of this 
feature. Heavy usage of highly 
compressed codecs requires the high end 
systems. (Dual 6 Core or Dual 8 Core 
systems)

Feature Description Recommended System
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Compatibility Chart

The following table lists the NVIDIA® driver, QuickTime®, Windows Media™, shared storage, 
Sony® XDCAM™, Panasonic® P2, and Avid Artist Series versions that were qualified with the 
Avid editing applications. 

AVCI-Intra Capture AVC-Intra capture with software 
codecs is supported.

32 core and higher Windows systems 
only. 
Note: If problems are encountered, please 
use a Nitris DX w/AVC-I capabilities or 
ingest at another resolution like DNxHD 
and transcode to AVC I. 

AVCI-Intra AVC-Intra(AVC-I) is a high 
quality, low bit-rate HD codec and 
is very CPU intensive. 

4-Way MultiCam Playback

Dual Quad Core, Dual 6 Core or Dual 8 
Core Systems

Four Stream Playback:

Dual Quad Core, Dual 6 Core or Dual 8 
Core Systems

AMA Workflows: Dual Quad, Dual 6 or 
Dual 8 core systems

Feature Description Recommended System

Item Versions Comments

QuickTime Support v7.7.8 (Windows)
v10.x, (v7.x legacy) (Macintosh)

Note: QuickTime v10X does not include 
QuickTime Pro options.

Windows Media 
Version Support

Windows Media Player 12 (for 
Windows 7)

If you do not have Windows Media 
Player, access the download at 
www.microsoft.com.

Windows Media export compatibility is 
subject to Microsoft Windows Media 
updates.

http://www.microsoft.com/en/us/default.aspx
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Avid Interplay 
Support

See Knowledge Base article on 
compatibility.

IMPORTANT: The Avid Interplay 
components that get installed on the 
editing application must be updated to 
the Avid Interplay version that is released 
with the editing application. These 
include the Media Indexer, Interplay 
Access, Interplay Framework, Interplay 
Transfer Client and ProEncode Client. 
The Avid Interplay Server components 
can remain on the previous releases listed 
as supported. For details, see the “Avid 
Editing Application Compatibility with 
Interplay Releases” doc on the 
Knowledge Base.

NVIDIA Driver 
Support

v347.52 See “Setting up the NVIDIA Card” on 
page 32.
For setting up the driver for stereoscopic, 
see the NVIDIA setup info in the 
Stereoscopic 3D Workflow Guide.

AMD Driver Support 14.301.1019.1001 Go to the following link.

Shared Storage 
Support

Avid Unity ISIS®. See “Shared Storage Support” on 
page 33.

Sony XDCAM driver v2.13 (XDCAM Transfer for 
Macintosh)

Windows FAM v2.3.2 and VFAM 
v5.0.2

The VFAM firmware version for 
PDW-U1 is 2.600. 
The PDW-U2 is 2.810. 
The driver can be downloaded from 
Sony's website http://esupport.sony.com/.

Panasonic P2 drive (Macintosh) v3.1.7

(Windows) v2.24

There is currently no P2 writeback 
support for Macintosh clients.

Avid Artist Series 
(Euphonix)

EuControl software v3.1.3 or later See the User’s Guide for information on 
Artist Series Color setup information.

Item Versions Comments

http://esupport.sony.com/
http://avid.force.com/pkb/articles/en_US/compatibility/Avid-Video-Compatibility-Charts
http://avid.force.com/pkb/articles/en_US/download/AMD-Supported-GPU-Drivers
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Avid Editing Application Compatibility with 
Pro Tools

General Co-Installation Notes:

• Install Pro Tools first and then Media Composer.

• You must uninstall all older versions of Media Composer or Pro Tools before installing 
newer versions.

• Co-install does not support both applications launched simultaneously.

• When you uninstall Pro Tools, choose to uninstall just the application and not the audio 
drivers or the editing application no longer sees the devices. On a Macintosh Pro Tools 10 
system, this is named the “Safe Uninstall.” On a Macintosh Pro Tools 11 system no 
uninstallation is required. On a Windows Pro Tools 10 or 11 system, you must select the first 
uninstall option - “Pro Tools Only” - which is not selected by default.

• Mojo SDI will not be supported with Media Composer or Pro Tools 11, but can still be 
connected in a co-install configuration for use with Pro Tools 10.

• If you install and configure Avid Mojo DX or Nitris DX hardware on your system, the 
editing application does not use any connected Pro Tools audio device for audio input/output 
operations. You can also use these audio devices with a software-only version of your Avid 
editing application.

• If you run into any issues, uninstall both applications and reinstall Pro Tools first, and then 
reinstall your editing application.

• Media Composer v5.0 and later and Pro Tools v8.0.3 and later do not include support for the 
Original Mbox. If you want to use the Original Mbox, you should use Media Composer v4.x 
and Pro Tools v8.0.1 instead.

• If you want to install your Avid editing application on a system with the Pro Tools Avid 
Video Engine installed, you must use one of the following configurations:

- Media Composer v5.5/NewsCutter v9.5 and later with Pro Tools v9.0 or later.

- Media Composer v5.0.x/NewsCutter v9.0.x with Pro Tools v8.5 or earlier.
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Co-installation Configurations and Audio Device 
Support

Avid Pro Tools Applications

Avid Mbox Family Audio Devices (3rd Generation)

Avid Mbox 2 Family Audio Devices

Pro Tools 
Product

MC/NC 
Software 
Only

MC/NC 
with Mojo 
DX

MC/NC/
with Nitris DX

Pro Tools 
Software Only

Co-install Co-install Co-install

Pro Tools|HD 
Native

Co-install/
Audio Device

Co-install Co-install

Pro Tools|HD Co-install/
Audio Device

Co-install Co-install

Pro Tools|HD, 
with chassis

Not Tested Not Tested Not Tested

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
with Nitris DX

Mbox 
(USB)

Co-install/
Audio Device

Co-install Co-install

Mbox Pro Co-install/
Audio Device

Co-install Co-install

Mbox Mini 
(USB)

Co-install/
Audio Device

Co-install Co-install

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
with Nitris DX

Mbox 2 
(USB)

Co-install/
Audio Device

Co-install Co-install
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Other Avid Audio Devices

External Controllers
Your Avid editing application supports the following external fader controllers or mixers for 
automation gain and pan recording or as control surfaces:

• Digi 002 (Windows only)

• Command|8

• Avid Artist Control

• Avid Artist Mix

Mbox 2 Pro 
(1394)

Co-install Co-install Co-install

Mbox 2 
Mini (USB)

Co-install/
Audio Device

Co-install Co-install

Mbox 2 
Micro 
(USB)

Co-install Co-install Not tested

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
with Nitris DX

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
with Nitris DX

Digi 002 
(1394)

Co-install/
Audio Device 
(Windows)

Co-install Co-install

Digi 003 
(1394)

Co-install Co-install Co-install

Eleven Rack 
(USB)

Not Supported Not Supported Not Supported

Fast Track 
Pro (USB)

Audio Device Not Supported Not Supported
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• Avid Artist Transport

• Avid Artist Color

External controllers or mixers are optional. They are not required for you to perform automation 
gain or pan recording on an Avid editing system.

The following table compares Avid external controllers and mixers.

Feature
Digi 002 
(MC only) Command|8

Avid Artist 
Control

Avid Artist 
Mix

Avid Artist 
Transport

Avid Artist 
Color

Control surface 
for transport 
controls and 
other functions

Yes Yes Yes Yes 
(transport 
only, no soft 
keys)

Yes

Provides audio 
play, input, and 
output

Yes No No No No

Record 
automation gain

Yes Yes Yes Yes No

Record 
automation pan

Yes Yes Yes Yes No

Flying faders Yes (8) Yes (8) Yes (4) Yes (8) No

Touch-sensitive 
faders

Yes Yes Yes Yes No

Touch-sensitive 
panners

No No Yes Yes No

Solo/mute Yes Yes Yes Yes No

Supports audio 
mixing

Noa No No No No

Latch mode 
(also known as 
Snap mode)

Yes Yes Yes Yes No

Number of 
steps of fader 
accuracy

1024 1024 1024 1024 Not applicable
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For more information on using these external fader controllers or mixers, see “Recording 
Automation Gain or Automation Pan Information” in the Help.

Setting up the NVIDIA Card

To set up the NVIDIA card, you must make sure you have the correct display driver version 
(install the display driver if necessary, and set the correct display settings. See the “Compatibility 
Chart” on page 26 for information on the supported driver(s).

Prior to setting up the NVIDIA card, check to make sure you have the correct display driver 
version. If you do not have the correct NVIDIA driver, you can install it from the Utilities folder 
that installs with your Avid application.
Installation files for these drivers are installed in the folder Program Files\Avid\Utilities\nVidia.

To check the NVIDIA display driver version:

1. Right-click the Desktop and select NVIDIA Control Panel. You can also open the Windows 
Control Panel and double-click the NVIDIA Control Panel icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.

The version number is listed in the Graphics card information section on the ForceWare 
version line.

To install the NVIDIA display driver:

1. Navigate to Program Files\Avid \Utilities \nVidia and double-click the folder that 
corresponds to your operating system.

2. Double-click the file for the applicable driver.

3. Follow the on-screen instructions, and then restart your system.

To setup multiple displays:

1. Right-click the Desktop, and select Nvidia Control Panel. 

2. In the settings window in the left of the window, click Set up multiple displays.

3. Select or deselect the desired monitors listed.

To set the Driver for Avid Editing Environments

1. Right-click the Desktop, and select Nvidia Control Panel.

2. Click Manage 3D Settings.

a. The Digi 002 can be used as a standalone audio mixer but not at the same time as it is being used as an automation gain or 
automation pan controller or control surface.
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3. Click the Global Setting tab.

4. Under Global presets, select Base Profile.

5. Scroll to locate the Power Management Mode. Select Prefer maximum performance.

6. Click Apply.

Reboot after installing the Nvidia software even if you are not prompted to do so. 
Never use the Windows “roll back driver” feature on the Nvidia driver. The driver version must 
match the rest of the components the Nvidia installer installs.

Shared Storage Support

The editing application has been tested in a shared storage environment with the following.

Limitations

The following limitations apply to the current version of the editing application.

Editing 
Application 
Operating 
System ISIS Clients

ISIS | 2500- ISIS 2000 Server
ISIS | 5500- ISIS 5000 Server
ISIS | 7500- ISIS 7000 Server ISIS | 1000 Server

Windows 8 v4.5, v4.6.1, v4.7 - 
v4.7.4, v4.7.5, 
v5.0a

a. ISIS Client v5.0 is applicable to ISIS | 1000 server only.

v4.2.2 Kit, v4.5, v4.6.1, v4.7 - v4.7.4, 
v4.7.5

v5.0

Windows 7 64-bit v4.2, v4.5, v4.6.1, 
v4.7 - v4.7.4, 
v4.7.5, v5.0

v4.2.2 Kit, v4.5, v4.6.1, v4.7 - v4.7.4, 
v4.7.5

v5.0

Macintosh v10.9 vv4.6.1, v4.7 - 
v4.7.4, v4.7.5, 
v5.0

v4.2.2 Kit, v4.5, v4.6.1, v4.7 - v4.7.4, 
v4.7.5

v5.0

Macintosh v10.8.x v4.2, v4.5, 4.6.1, 
v4.7 - v4.7.4, 
v4.7.5, v5.0

v4.2.2 Kit, v4.5, v4.6.1, v4.7 - v4.7.4, 
v4.7.5

v5.0

Macintosh v 10.10 v4.7.4, v4.7.5, 
v5.0

v4.7.4, v4.7.5 v5.0
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AMA 

➤ Bug Number: MCDEV-2. BlackMagic files greater than HD will not link inside Media 
Composer using the Avid QuickTime Plug-in unless the Black Magic Design Desktop Video 
Software is installed. Access www.blackmagicdesign.com for information on the Black Magic 
Design Desktop Video Software.

➤ Bug Number: . Since a given file type may be supported by multiple AMA plug-ins, for best 
results choose a specific AMA plug-in rather than Autodetect when performing an AMA Link to 
File. When performing an AMA Link to a volume, Autodetect will normally select the correct 
plug-in, but if it doesn't, choose a specific AMA plug-in and perform the AMA Link to volume 
again. 

➤ Bug Number: UDevC00182286. When performing an AMA link to MXF media, you should 
not select the Autodetect plug-in option. Choose the applicable plug-in to perform the AMA 
Link to File.

➤ Bug Number: UDevC00179996. If you load an AMA-linked clip into a monitor, then enable 
Dynamic Relink and set the Preferred media format in the Dynamic Relink Settings dialog box 
to “Any native media,” the media displays as offline. This is as designed. If there is no native 
MXF or OMF media to display, the AMA-linked clips only display when you select AMA as the 
preferred media format.

➤ Bug Number: UDevC00178140, UDevC00180089. If you are AMA linking BlackMagic 
Cinema Camera DNxHD movies, these files link as Matte Key effects rather than master clips. 
Therefore these files cannot be transcoded. To workaround this, open Import Settings, and in the 
Image tab set Alpha Channel to Ignore. 

➤ Bug Number: UDevC00180039. Media Indexer limitation: When you check in an AMA file, 
the system does not create .spaaf files if the workspace for .spaaf files is not mounted correctly 
on the ISIS client. Before you begin to check the AMA files into Interplay, you must manually 
create the top level folder for the .spaaf files and configure the Media Indexer to index that 
folder. Avid recommends that you dedicate a specific workspace for the spaaf files. The spaaf 
workspace on ISIS must be mounted and accessible by the editing user on the editing machine. 
On a Mac OS X system, the workspace must be mounted using the same name as the workspace. 
The checkin will fail if this condition is not met. 

The following shows mount point examples for a workspace named “spaafFiles”:

• Correct: /Volumes/spaafFiles

• Incorrect: /Volumes/spaafFiles1

www.blackmagicdesign.com/support
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The incorrect mount point can occur if you have duplicate workspace names. The ISIS client 
adds a digit to a workspace name if it encounters a duplicate name. This can happen if you have 
two ISIS systems. Avoid duplicate workspace names.

➤ Bug Number: UDevC00178051. Do not enable Audio Waveforms if you are AMA linking to 
Arri clips. 

➤ Bug Number: UDevC00178650. XDCAM AMA linked files might not appear in the Media 
Tool. XDCAM AMA linked volumes do appear in the Media Tool. 

Application Manager

➤ Bug Number: AMPT-1727. The APPS and Feeds tab remain empty after you license via a 
Floating License.

➤ Bug Number: AMPT-1808. Daily notification of a support contract expiration starting 7 days 
prior to expiration is not currently working.

➤ Bug Number: AMPT-1030. When deactivating the editing application and performing an 
upgrade, the System ID is not automatically pre-populated in Application Manager. For 
information on locating your system ID, see the Installation Guide.

➤ Bug Number: AMPT-1731. The trial period for New Blue Titler 2 does not display in 
Application Manager.

➤ Bug Number: AMPT-1719. Updating New Blue Title 1 in Application Manager should be 
allowed without an active subscription. 

Avid Artist Color

➤ Bug Number: UDevC00157064. Some soft keys do not light up when you use the Avid Artist 
Color with your Avid editing application, including the following:

• HSL Shift Layer: all soft keys

• HSL Bank 2 Shift Layer: all soft keys

• Curves: F8 and F9 soft keys

• Curves Shift: F1, F3, F6, and F9 soft keys

• Secondary: F2, F7, F8, and F9 soft keys

• Secondary Shift: all soft keys

The soft keys listed above function normally even when they do not light up.

http://avid.force.com/pkb/articles/en_US/readme/Media-Composer-Software-8-0-Documentation
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➤ Bug Number: UDevC00163957. Hue offset color wheels might not appear when you use Artist 
Color to enter Color Correction mode the first time after start your Avid editing application. Any 
parameter update will draw them.

Workaround:  When you make any change in a parameter in the Color Correction tool, the 
color wheels appear.

➤ Bug Number: UDevC00156948.  (The F2 soft key (Next HSL Subtab) does not function until 
after you apply a color correction to your footage. If you press F2 (Next HSL Subtab) on the 
Artist Color surface before you apply a color correction, you get a system beep and the subtab 
does not change.

➤ Bug Number: UDevC00157932. If you use the HSL shift control for trackballs, you might see 
the trackballs controlling the wrong monitor during shuttle. For example, if you press Shift and 
then use the right trackball to shuttle, and then move either the left or the center trackball, you 
might see the other trackballs now control the right monitor. 

➤ Bug Number: UDevC00164772. When you first ope n the Color Correction tool, either with the 
Artist Color or with the mouse, incorrect color correction values might display in parameter 
fields. This problem is intermittent, and it does not occur after you change a parameter value.

Workaround:  Adjust any parameter. The correct values display in the Color Correction tool.

➤ Bug Number: UDevC00164954. (Macintosh only): The EuControl application does not open 
when you select Edit Settings in the Controller Settings dialog box. To configure your EUCON 
device, you must open the EuControl application by clicking the EUCON icon in the dock, and 
then selecting Window > EuControl Settings.

Avid Artist DNxIO

➤ Bug Number: MCDEV-3702. Some Open IO cards do not support all RGB formats and RGB 
10-bit stutters during playback. You can switch back to YUV colors space, or if you need to edit 
in RGB, disable the hardware temporarily.

➤ Bug Number: BMD-6. When you perform a down convert in an RGB project, the down 
converted outputs will be YUV.

➤ Bug Number: BMD-50. Unless video input is also connected, no audio is recorded when trying 
to perform audio punch-in or any audio only capture.

Workaround:  If you do not have a video source connected, you can perform audio only capture 
or punch-in if you loop video OUT to IN on the Artist DNxIO.
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Background Render

➤ Bug Number: UDevC00186139 . We do not support AMA linked QuickTime media with alpha 
in Background Render.

Background Transcode

➤ Bug Number: UDevC00178938. The Background Queue window might stop refreshing 
intermittently. Select Open Background Queue window from the task bar (Windows) or menu 
bar (Macintosh) to view the background status in a browser.

➤ Bug Number: UDevC00180218. If you perform an ‘alldrives’ Console command and mount a 
network drive, a background transcode will not be successful to the mounted network drive. A 
foreground transcode will transcode successfully.

Capture

➤ Bug Number: MCDEV-3641. (Mac) Capturing Apple Pro Res in UHD 50/59.94 results in a 
video overrun error.

➤ Bug Number: UDevC00181736. If you are on a Windows 8 system, you might notice a slight 
stutter while recording (or in Capture Mode) but the video will record without any skips or 
dropped frames.

Compatibility

➤ Bug Number: MCDEV-975. Mojo hardware does not support projects with RGB. You will 
receive the message “Current hardware is not compatible with this project’s settings and is being 
switched to inactive.”

➤ Bug Number: MCDEV-2425. If you have a bin with AMA linked QuickTime in Media 
Composer v8.3 and you open the bin in Media Composer v7.0.4.1, the editing application 
crashes. The bin opens successfully in Media Composer v8.2. A future v7.0.4. release will 
support opening an 8.3 bin with AMA linked QuickTime.

➤ Bug Number: . Software viewers and fullscreen playback is limited to 8 bits.

➤ Bug Number: MCDEV-1093. When working with some HDMI monitors and higher than HD 
media, switching focus from the editing application, to the desktop and then back to the editing 
application might result in a delay before the image displays on the client monitor.
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➤ Bug Number: MCDEV-2365. When using a trial version of the Sapphire plug-in, the editing 
application will crash. You can apply a Sapphire effect with a non-trial version of the plug-in.

➤ Bug Number: MCDEV-348. (Mac) With some versions of the Mac OS, if you open the Title 
Tool, select Help and type any text to the Search field and then select, Show All Help Topics, the 
Title Tool will crash. To open the Help from within the Title Tool, select Help and choose 
Contents. The Media Composer Help will open to the “Creating Titles” topic.

➤ Bug Number: MCCET-206. (Mac) In some instances, when Matrox drivers are installed on 
your system, you might receive a beachball when using the Color Picker. If this occurs, type the 
following in the Console Window: useCrossPlatformColorPicker 1

➤ Bug Number: . When transcoding LogC AMIRA clips that have embedded LUTs, and you 
decide not to apply the color transformations during the transcode, the color metadata will be 
carried forward in the new clip but the AMIRA LUT won’t be embedded in the new clip. This 
will then lead to improper colors when looking at the transcoded clip since the required LUT 
won't be available.

Workaround:   Use the original AMIRA clip or transcode with “apply color transformations” 
enabled

➤ Bug Number: UDevC00166431. You might receive AMPI Subsystem errors when launching 
the editing application. Avid recommends that you refer to the following Knowledge Base article 
for information on possible causes.
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=377091

➤ Bug Number: UDevC00185899. (Macintosh) You can not open the editing application Help in 
Google Chrome. Use a browser such as Safari or Mozilla to open the help.

➤ Bug Number: UDevC00151588. You must have the MediaNetwork client installed on your 
system in order to play linked AMA clips from the MediaNetwork shared storage.

➤ Bug Number: . The Standalone Transfer Manager will be supported with this release, except for 
compatibility with Airspeed Classic and Open I/O devices.

➤ Bug Number: UDevC00173830. When attaching and detaching the Nitris DX hardware the 
system might restart.

Dynamic Media Folder (DMF)

➤ Bug Number: UDevC00180779. If you select the QuickTime folder plug-in from the DMF drop 
down menu and attempt to link to QuickTime files inside the DMF watch folder, an error 
message will occur stating the files cannot be linked and the DMF process will terminate. 

http://avid.force.com/pkb/articles/en_US/error_message/en377091
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Workaround:  Select the Autodetect AMA Plug-in from the DMF drop-down menu to link to 
QuickTime files and/or folders.

➤ Bug Number: .  If you are using a removable drive or reader as a DMF watch folder, make sure 
that “Automatically AMA-link to volumes” is deselected in the AMA Settings.

➤ Bug Number: . The following media types are not currently supported with Dynamic Media 
Folders in Media Composer:

• Uncompressed 8bit and 10b QuickTime files

• QuickTime files that include an alpha channel

• Sony XDCAM-EX

Dynamic Relink

➤ Bug Number: MCCET-522. Dynamic Relink picks the wrong video when there is overlapping 
timecode.

Workaround:  Media management in Avid workflows requires that all clips associated with a 
physical source id (e.g. Tape ID) must have non-overlapping timecode ranges. If you have clips 
with overlapping timecode ranges for the same physical source id, you can modify the tape id to 
be unique in Media Composer and transcode or consolidate to new clips.

Effects

➤ Bug Number: . You cannot import a Matte that does not match the project frame rate.

➤ Bug Number: . sSource settings are not available for matte keys.

➤ Bug Number: . AVX 1 effects are no longer supported and will not be recognized in this latest 
version of Media Composer. Please contact the respective 3rd-party plug-in vendor for an AVX2 
64-bit version of any existing plug-in that you might have purchased. The following Avid AVX1 
effects will automatically be promoted to AVX2:

• Avid Pan & Zoom

• Region Stabilize

• RGB Keyer

When you load a previously-generated sequence containing one of these effects, they will 
automatically be promoted to new corresponding AVX2 effects. These effects will not be 
recognized by earlier versions of Media Composer.
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➤ Modifying Pan Values in the Timeline: You can display different pan values in the Timeline for 
different audio tracks by clicking the Clip Gain/Pan button in the Track Control panel and 
selecting one of the pan value options. However, if you want to manipulate pan control points 
(either adding a keyframe or adjusting a keyframe), you must make sure all audio tracks display 
the same pan values. To do this, Alt+click the Clip Gain/Pan button in the Track Control panel 
for any audio track and select a pan value option.

High Resolution

➤ Bug Number: . In a greater than HD project, if you have selected Proxy Timeline in the Format 
tab and are in YCbCr Color Space, the only resolution available for media creation is 
DNxHR LB.

➤ Bug Number: . If your project is set to RGB Color Space, Proxy Timeline is not available. You 
can however, transcode to proxy dimensions. In RGB Color Space, only DNxHR 444 is available 
for media creation.

➤ Bug Number: . In an HD project, if you want to transcode the source media to DNxHR and 
keep the original size (for example, to create 2K DNxHR), you need to temporarily change the 
project raster (to anything larger than HD) so that the DNxHR codec is available in the transcode 
menu. Once completed, switch back the project to HD.

➤ Bug Number: . For larger than HD projects, “Same as Source” export is not available.

➤ Bug Number: . Pro Tools does not yet support higher than HD sequences. You must do an HD 
mixdown of your tracks before sending the sequence to Pro Tools.

➤ Bug Number: . DNxHR is not available as a QuickTime option. 

Interplay

➤ Bug Number: . Important: Interplay does not currently allow check-in of higher-than-HD 
sequences and DNxHR media. You can still link to higher-than-HD media and edit within an HD 
frame size. Any transcoding and rendering must also be done in an HD proxy size. 

For the final delivery in a Cinematic or UltraHD format size, you can open the sequence on a 
Media Composer editing station, that is not connected to Interplay, and change the sequence 
format to an UHD or DCI frame size. You can then link to the original camera sources for the 
final finishing, rendering and output. These sequences and rendered media cannot be checked in 
to Interplay but can be saved to a shared ISIS workspace for access by other systems.
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➤ Bug Number: . (Interplay) Dynamic relink is not currently supported for media that requires 
pulldown. Therefore, you can only use it with clips where the media has been acquired at the 
native frame rate (without pulldown).

➤ Bug Number: UDevC00164931. (Avid Interplay and Windows 7) Can't locate Media Indexer 
on Avid editor after first install. After an initial installation of the editor and Interplay support 
software, the editing application may fail to locate the Media Indexer. This can happen if some of 
the Avid Service Framework services have not started correctly.

Workaround:  Open the Workgroup Properties tool on the editor and check whether any of the 
services are not running. Restart any services as required. Then restart the Avid editing 
application again. You may have to do this the first few times that you start the editor. After a few 
times the services will begin starting automatically, even after a reboot.

iXML Metadata in BWAV Files

➤ Bug Number: . Multi-channel track identification information is not read from iXML

➤ Bug Number: . Markers in the iXMl are not imported when the file is linked.

➤ Bug Number: . Implied channel group information by file name pattern, as used by the audio 
import code, is not available when using the WaveAIFF AMA.

➤ Bug Number: . Channel group information, the iXML data that is used to group multiple mono 
files into a single clip, is not interpreted. To workaround this, reconstruct the channel groups 
manually with AutoSync.

To reconstruct the multi-channel track identifications, set in the AMA setting link options for 
Multichannel audio prior to linking, or edit afterward with multi-channel audio pane of clip 
menu “modify” dialog.

Output

➤ You cannot control down/cross conversion from the Video Output Tool when in TrueP mode for 
1080p projects or when you are in Stereoscopic mode.

Workaround:  When in stereoscopic mode or have True Progressive output set for 1080p 
projects, the down-convert and cross-convert options are not available. To output at a rate 
different than the project format, go to the Format tab and change the output project setting.
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Performance

➤ Bug Number: UDevC00179008. Foreground performance of the application could be impacted 
while waveforms cache for systems attached to XDCAM EX device.

Play

➤ Bug Number: MCDEV-3005. The internal structure of Apple ProRes requires a width that is a 
multiple of 16 pixels. For cases where the media (or project dimensions) does not fit this 
requirement, extra processing is required to respect this multiple. This can cause a performance 
degradation noticeable during playback and processing. The common instances are when 
working at project dimensions 1998 x 1080 (2K DCI Flat) and 3996 x 2160 (4K DCI Flat).

➤ Bug Number: MCDEV-2046. You might see dropped frames playing back DNxHR HQX media 
with hardware output downconvert, in Full Quality 10-bit mode. 

Workaround:  Playback DNxHR HQX in Full Quality (green/green) 8-bit mode.

➤ Bug Number: MCDEV-1976. You might see dropped frames working in 4K high frame rate 
projects and Multicam. We will improve the performance in a future release.

➤ Bug Number: UDevC00153838. You might receive an “Exception: The sequence or one of its 
source elements is too long to be played” error if you have a sequence over 12 hours.

➤ Bug Number: MCDEV-2210, MCDEV-2299, MCDEV-2298. When working in higher than HD 
projects, playing back AMA linked media in full quality mode (green/green) might not playback 
smoothly. 

Workaround:  Set the playback quality mode to Draft Quality mode (yellow/green) or Best 
Performance mode (yellow/yellow).

Project Sync

➤ Bug Number: UDevC00179779. If you use Interplay Assist to create shotlists, you can save the 
shotlists in a folder within a synced project folder in your Interplay database. However, updating 
the synced project from the editing application does not update the bin with the shotlist. This is 
as designed. The Interplay synced project workflow uses projects created and edited in your Avid 
editing application and then saved to Interplay so other editing application users can access the 
same project.
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Workaround:  Create your shotlists in the editing application and then update your project. The 
shotlist appears in the synced project folder in Interplay as well as in the bin in your editing 
project.

➤ Bug Number: UDevC0017968. If you create a new synced project, delete it before opening the 
project on your Avid editing machine, and then add the project from Interplay and open it, the 
project is empty and contains no bins. This results from creating a synced project, which creates 
the necessary synced project folder in your Interplay database, but not creating any content for 
the project.

Workaround:  If you open a project that has no content, you can create a new bin. The new bin 
is saved to Interplay, which then creates the folder structure for the media in your synced project.

➤ Bug Number: UDevC00179847. Opening a bin from another project while you work in a 
synced project does not add that bin to the project saved to Interplay, and updating a synced 
project from Interplay does not update a bin opened from a different project. Only bins that are 
part of an Interplay synced project are saved to Interplay.

Workaround:  If you want to add media from another project to your Interplay synced project, 
create a new bin and add the media directly to it. When the bin is saved to Interplay, your synced 
project updates correctly.

➤ Bug Number: UDevC00180164. You cannot update a sequence from Interplay in a synced 
project by right-clicking the Source or Record monitor and selecting Update from Interplay.

Workaround:  To update a sequence in a synced project, click the bin with your sequence to 
activate it, and then select File > Save Bin, or select the bin, and then select Bin > Update Bin 
from Interplay. For more information on saving sequences to Interplay, see “Updating a Synced 
Project” in the Help for your Avid editing application.

➤ Bug Number: UDevC00180195. If two or more editors are working on the same Interplay 
synced project, deleting folders and bins by one user might create conflicts and cause the second 
user’s editing application to become unstable. This can happen when one editor moves a folder 
that contains a bin to the Trash and then saves the project. This updates the project on Interplay. 
If a second editor working on the same synced project at the same time has the bin open, updates 
his project from Interplay, the now-deleted bin stays open in the local project even though the 
Trash folder shows the bin has been deleted. If the second editor then makes a change to this bin 
and tries to save it, the editor receives an error stating that the bin has been deleted from 
Interplay. This error message might appear several times. If the second editor dismisses the error 
messages and tries to close the bin, an assertion error appears and the application becomes 
unresponsive.

Workaround:  Avid recommends that you do not delete folders from your Interplay synced 
project if other users are working on the same project simultaneously.
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QuickTime

➤ Bug Number: UDevC00159820. QuickTime Reference movies are not supported by 
QuickTime Player X. They are still supported in QuickTime Player 7 on the Macintosh. They are 
also not supported in QuickTime version 7.6.9 on Windows.

Stereoscopic 3D

➤ A software developer's kit is now available for 3rd-party partners who would like to build AMA 
plug-ins, AVX2 effects, or develop applications that support stereoscopic 3D media/sequences 
compatible with Avid Media Composer. This developer's kit is available on the Avid website.

➤ 720p Stereoscopic projects are not currently supported with Open I/O hardware from 3rd-party 
vendors.

➤ Bug Number: UDevC00164741. If a rolling title is used in an Over\Under stereo project, you 
may get the wrong scaling and cropping of lines.

➤ Stereoscopic projects are not supported on Avid Interplay.

➤ NVIDIA 3D Vision

• Avid currently only supports the NVIDIA 3D Vision Home bundle (which includes the 3D 
glasses, emitter hub and display monitor). The 3D Vision Pro has not been successfully 
tested.

• Full screen playback on an NVIDIA 3D Vision monitor is only supported on a Windows 
system. 

• Due to an NVIDIA driver issue, the first time that the full screen play window appears, the 
application will resize to a single monitor. Resize the application as necessary. You can reset 
your window positions by clicking on a toolset in the menu.

➤ Bug Number: UDevC00161499. Ancillary data output is not supported if you are working in 
full stereoscopic format.

Timeline

➤ Bug Number: MCDEV-2421. If you edit a clip into the Timeline with classic markers, then 
perform an Undo and a Redo, the system might crash.

➤ Bug Number: UDevC00164751. If you have a sequence loaded in the Timeline, and you have 
waveforms on, clicking or dragging in the Timeline does not stop the waveform from drawing. 
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Workaround:  Hold Cmd + . to stop the waveform from drawing. 

Titles

➤ Bug Number: . Titles created with NewBlue are not currently real-time.

➤ Bug Number: . Dropping a NewBlue (or any filter) between an IN-OUT does not respect the 
In-OUT, you need to create some edit points to mark the duration.

➤ Bug Number: UDevC00176468. (Macintosh) Icelandic characters are not supported when 
working with the Title Tool. As a workaround, you can use the NewBlue Titler Pro plugin which 
does support Icelandic characters.

XDCAM

➤ Bug Number: UDevC00177208. XDCAM Multicam media might appear choppy in the 
Source/Record monitors when you perform reverse playback with the J key.

➤ Bug Number: . You cannot export an XDCAM clip or sequence that is less than 2 seconds long.

User Interface

➤ Bug Number: UDevC00162819. You cannot copy and paste timecode values into the Source or 
Record monitors. To enter timecode in the monitors, select the monitor and then type in the 
appropriate timecode values.

➤ Bug Number: UDevC00164678. You can drag audio keyframes past adjacent audio keyframes. 
Moving an audio keyframe past another keyframe causes the keyframes to swap values. For 
example, set volume levels on two audio keyframes: Keyframe A for low volume (left keyframe) 
and Keyframe B for high volume (right keyframe). If you then drag Keyframe A to the right of 
Keyframe B, Keyframe A now displays the higher volume level. 

➤ Bug Number: UDevC00164995. (Macintosh only) If you load a group clip into the Source 
monitor while in MultiCamera mode, the monitor displays the clip as if MultiCamera mode is 
still selected, although the action of loading the group clip actually causes the Avid editing 
application to enter Source/Record mode. If you play back the clip, you only see the linecut and 
cannot perform MultiCamera edits.

Workaround:  To turn off the Multicamera mode display, select Special > Multicamera Mode, 
and make sure MultiCamera Mode is not selected.
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➤ Bug Number: UDevC00165159. (Macintosh only) If you render a sequence containing a title 
by selecting Clip > Render In/Out or by right-clicking the sequence and selecting Render In/Out, 
the progress bar displaying the status of the render operation does not update and the application 
appears to become unresponsive. However, even though the progress bar does not advance, the 
rendering operation continues. When it completes, the progress bar closes.
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including 
photocopying and recording, for any purpose without the express written permission of Avid Technology, Inc.

Copyright © 2014 Avid Technology, Inc. and its licensors. All rights reserved.

Portions © Copyright 2003-2007 of MOG Solutions.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a 
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the 
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, Assistant 
Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid 
DNxHD, Avid DS Assist Station, Avid Ignite, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, Avid Mojo, Avid 
Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, Beat Detective, Beauty 
Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Bruno, C|24, CaptureManager, ChromaCurve, 
ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, Command|24, Command|8, 
Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, D-Command, D-Control, Deko, DekoCast, D-Fi, D-fx, Digi 002, Digi 003, 
DigiBase, Digidesign, Digidesign Audio Engine, Digidesign Development Partners, Digidesign Intelligent Noise Reduction, 
Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, DigiSnake, DigiSystem, Digital 
Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, Do More, DPP-1, D-Show, DSP 
Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, Expander, 
ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame Chase, FXDeko, 
HD Core, HD Process, HDpack, Home-to-Hollywood, HYBRID, HyperSPACE, HyperSPACE HDCAM, iKnowledge, Image 
Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, InGame, Instantwrite, Instinct, Intelligent Content 
Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, Intelli-sat Broadcasting Recording Manager, InterFX, 
Interplay, inTONE, Intraframe, iS Expander, iS9, iS18, iS23, iS36, ISIS, IsoSync, LaunchPad, LeaderPlus, LFX, Lightning, Link & 
Sync, ListSync, LKT-200, Lo-Fi, MachineControl, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, 
MassivePack, Massive Pack Pro, Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMix, Media Reader, Media 
Recorder, MEDIArray, MediaServer, MediaShare, MetaFuze, MetaSync, MIDI I/O, Mix Rack, Moviestar, MultiShell, NaturalMatch, 
NewsCutter, NewsView, NewsVision, Nitris, NL3D, NLP,  NSDOS, NSWIN,  OMF, OMF Interchange, OMM, OnDVD, Open Media 
Framework, Open Media Management,  Painterly Effects, Palladium, Personal Q, PET, Podcast Factory, PowerSwap, PRE, 
ProControl, ProEncode, Profiler, Pro Tools, Pro Tools|HD, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, QuickPunch, 
QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket 
Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, ScriptSync, 
SecureProductionEnvironment, Serv|GT, Serv|LT,  Shape-to-Shape, ShuttleCase, Sibelius, SimulPlay, SimulRecord, Slightly Rude 
Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, SoundReplacer, SPACE, SPACEShift, SpectraGraph, SpectraMatte, 
SteadyGlide, Streamfactory, Streamgenie, StreamRAID, SubCap, Sundance, Sundance Digital, SurroundScope, Symphony, SYNC 
HD, SYNC I/O, Synchronic, SynchroScope,  Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, TimeLiner, Titansync, Titan, TL 
Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, 
tools for storytellers, Transit, TransJammer, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Video the Web Way, VideoRAID, 
VideoSPACE, VTEM, Work-N-Play, Xdeck, X-Form, Xmon and XPAND! are either registered trademarks or trademarks of Avid 
Technology, Inc. in the United States and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or 
other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows 
is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other 
trademarks contained herein are the property of their respective owners. 
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